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01 - Manually Created Organizational Diagrams 

 

Prior to stepping through the power of the Microsoft Office Visio 2007 Organization Diagram Wizard, it 

is best to go back to the basics and understand how Visio Organizational Diagrams are created. This first 

section will provide the user with a step-by-step, click-by-click guide to the manual creation and editing 

of Visio Organizational Diagrams. The user is strongly encouraged to keep this document open and close 

at hand while working within Visio 2007. In this manner, the user will be able to reference back to the 

click-by-click steps and, with practice and repetition, will be able to create professional diagrams with 

absolute ease. 

Creating a New Organizational Diagram 

 

There are essentially two methods of starting a new Organizational Diagram within Visio 2007. The first 

involves beginning the diagram from the new Visio 2007 “Getting Started” screen. Each time the user 

double-clicks on a Visio shortcut on the user’s desktop, or chooses Microsoft Office � Microsoft Office 

Visio 2007 from the Microsoft Windows XP or Microsoft Windows Vista Start Menu, the application Visio 

launches and the user is presented, by default (unless the user has opted not to show the Getting 

Started screen from the Tools � Options… dialog), with the Getting Started Screen. 

Getting Started Methodology 

 

While the Getting Started Screen is active in Visio 2007 (both Standard and Professional editions), look 

at the Template Categories at the Left Side of the Getting Started set of Task Panes. Left-Click to select 

the Category listed as Business.  

 

This action will display the Business Category and its store of available Visio Business Templates. 
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Left-Click on the Organization Chart Icon in either the Featured Templates area or the Other Templates 

area of the Business Category Page of the Getting Started Task Area. Next, Left-Click to choose either the 

US units or the Metric Radio Button, depending on the desired target output. Finally, Left-Click on the 

Create Command Button to confirm the choices and create the new blank Organizational Diagram. 

 

File Menu Methodology 

 

Whether or not the Getting Started Screen is active in Visio 2007 (both Standard and Professional 

editions), Left-Click on the File Menu in the Visio 2007 Menu Sets at the top of the Visio environment.  

Choose File � New � Business � Organization Chart (US units) from the Visio File Menu. 
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Either the Getting Started methodology, or the File � New methodology will result in the creation of a 

new blank Organizational Diagram. 

The environment will contain a collection of Visio Stencils at the left in the Shapes Pane. The Shapes 

Pane will contain three Stencils; Borders and Titles, Backgrounds, and Organization Chart Shapes. The 

Organization Chart Shapes Stencil will be the active Stencil. 

The Organization Chart Shapes stencil contains 14 Master SmartShape symbols. These include: 

• Executive 

• Manager 

• Position 

• Consultant 

• Vacancy 

• Assistant 

• Team Frame 

• Staff 

• Title / Date 

• Multiple shapes 

• Three positions 

• Title 

• Dynamic connector 

• Dotted-line report 
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Any time that the user drags and drops any of these Master SmartShape symbols onto the Visio Diagram 

Page, they are creating an instance of that Master SmartShape symbol. 

The center area of the Visio Environment is the Diagram or Drawing Page. This is the area where the 

actual Organizational Diagram will be created. 

Floating over, and contained within, the Diagram Page (unless the user has otherwise docked the 

toolbar) is the Organization Chart Toolbar. More will be discussed about the Organization Chart Toolbar 

later in this document. 

Among the Visio Menu lists the user will find, between the Shape Menu and the Window Menu, the 

Organization Chart Menu. This menu contains a collection of commands for working with individual and 

selections of Visio Organization Chart SmartShape symbols. These menu commands will be discussed 

later in this document. They include: 

� Re-layout 

� Best Fit to Page 

� Arrange Subordinates… 

� Hide Subordinates 

� Move Subordinates � Left/Up 

� Move Subordinates � Right/Down 

� Change Position Type… 

� Synchronize � Create Synchronized Copy… 

� Synchronize � Expand Subordinates 

� Import Organization Data… 

� Export Organization Data… 

� Compare Organization Data… 

� Change Spacing… 

� Options… 

 

The Executive SmartShape Symbol 

 



Visio 2007 Organizational Diagramming Page 11 

 

The first step in actually manually creating a Visio Organizational Diagram is to add the absolute Top 

Level person to be shown on the diagram. This is generally the CEO, the President, or other Top 

Executive. To add this person to the diagram, Left-Click, (Hold the Left Mouse Button Down) Drag, and 

Drop the Executive Master SmartShape symbol found on the Organization Chart Shapes Stencil. Drop 

the instance at a point near the top of the diagram Page and centered on the diagram Page. 

When this action is complete, the Executive SmartShape symbol will be displayed on the page, and (by 

default unless the feature is turned off) a small assistance dialog will be displayed informing the user as 

to the proper methodology for creating the connected hierarchy in the Organizational Diagram. 

 

The message states “To connect shapes, drop a shape on top of the superior shape.” In other words, to 

add a Manager reporting to the Executive, simply Left-Click, (Hold the Left Mouse Button Down) Drag, 

and Drop the Manager Master SmartShape symbol found on the Organization Chart Shapes Stencil 

directly on top of the Executive SmartShape symbol. Visio will automatically take care of providing a 

Dynamic Connector SmartShape symbol and gluing the Beginning of the Dynamic Connector SmartShape 

symbol, utilizing Dynamic Glue, to the Executive SmartShape symbol, and gluing the Ending of the 

Dynamic Connector SmartShape symbol, utilizing Dynamic Glue, to the Manager SmartShape symbol 

To close this dialog, Left-Click the OK Command Button. To ensure that it does not pop up again, Left-

Click to Check the Don’t show this message again. Check Box prior to Left-Clicking on the OK Command 

Button. 

Adding Subordinates 

 

Once an Executive has been added to the Diagram, additional subordinates may be added by dragging 

them from the stencil and dropping them on the Organizational Diagram SmartShape symbol 

representing their superior. As stated before, simply Left-Click, (Hold the Left Mouse Button Down) 

Drag, and Drop the Manager Master SmartShape symbol found on the Organization Chart Shapes Stencil 

directly on top of the Executive SmartShape symbol. Visio will automatically take care of providing a 

Dynamic Connector SmartShape symbol and gluing the Beginning of the Dynamic Connector SmartShape 
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symbol, utilizing Dynamic Glue, to the Executive SmartShape symbol, and gluing the Ending of the 

Dynamic Connector SmartShape symbol, utilizing Dynamic Glue, to the Manager SmartShape symbol. 

This process may be repeated for each additional Manager reporting directly to the Executive. 

Adding One Subordinate at a Time 

 

To add one subordinate SmartShape symbol at a time to the diagram, follow the procedure detailed 

above, dropping Manager SmartShape Symbols on top of Executive SmartShape symbols, dropping 

Position SmartShape Symbols on top of Manager SmartShape symbols, dropping Vacancy SmartShape 

symbols, Consultant SmartShape symbols, and Assistant SmartShape symbols as necessary to describe 

the structure of the Organization being documented. 

A resultant Organization might look something like that shown below. 

 

Note that as each SmartShape symbol is added to the Organizational Diagram, each SmartShape symbol 

displays the text “Name” and “Title” on the face of the particular symbol. This text may be easily 

replaced by editing the Shape Data for that given SmartShape symbol. To edit the Shape Data for any 

given SmartShape symbol, Right-Click on the SmartShape symbol and select Properties from the 

SmartShape symbol’s context menu. This action will cause the Shape Data dialog to be displayed. 
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Left-Click into each field that requires a new value to be set. Edit the text as necessary. 

 

When all edits have been completed, Left-Click the OK Command Button to confirm the changes and 

close the dialog. The SmartShape symbol’s Text will be updated to reflect these changes. 

 

Keep in mind that by default, only the Name and Title fields are visible on the face of the SmartShape 

symbol. As will be discussed later, this is totally customizable and user configurable. 

Adding Three Subordinates at the Same Time 

 

If, for any reason, exactly three Position subordinates report to the same singular Manager, the process 

of adding the three Position SmartShape symbols may be shortened by selecting the Three positions 

Master SmartShape symbol from the Organization Chart Shapes stencil, Left-Click, (Hold the Left Mouse 

Button Down) Drag, and Drop the Three positions Master SmartShape symbol directly on top of the 
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Manager SmartShape symbol. Visio will automatically take care of providing a Dynamic Connector 

SmartShape symbol for each Position SmartShape symbol and glue the Beginning of the Dynamic 

Connector SmartShape symbol, utilizing Dynamic Glue, to the Manager SmartShape symbol, and glue 

the Ending of each Dynamic Connector SmartShape symbol, utilizing Dynamic Glue, to the individual 

Position SmartShape symbols. The resultant three Position SmartShape symbols will be evenly spaced 

below the Manager SmartShape symbol. 

Adding Multiple Subordinates at the Same Time 

 

A more generic, and perhaps, more flexible method for adding multiple subordinates under a superior is 

to make use of the Multiple shapes Visio SmartShape symbol found on the Organization Chart Shapes 

stencil. Left-Click, (Hold the Left Mouse Button Down) Drag, and Drop the Multiple shapes Master 

SmartShape symbol found on the Organization Chart Shapes Stencil directly on top of the desired 

superior SmartShape symbol. Visio will not actually place a new SmartShape symbol, but, rather, will 

trigger the execution of some Automation Code which will display a small dialog as shown below. 

 

This dialog allows the user to (a) specify the number of subordinate SmartShape symbols to be added 

under the superior SmartShape symbol selected by the Drop action, and (b) specify which Master 

SmartShape symbol will be used to create and glue the multiple subordinate SmartShape symbols 

Visio will automatically take care of providing a Dynamic Connector SmartShape symbol and gluing the 

Beginning of the Dynamic Connector SmartShape symbol, utilizing Dynamic Glue, to the superior 

SmartShape symbol, and gluing the Ending of the Dynamic Connector SmartShape symbol, utilizing 

Dynamic Glue, to each of the subordinate SmartShape symbols. This process may be repeated for each 

additional superior SmartShape symbol requiring multiple subordinate SmartShape symbols. 

Adding Staff Members 

 

An additional SmartShape symbol used in Organizational Diagrams is the Staff SmartShape symbol. The 

Staff SmartShape symbol is used similarly to any other Organization Chart SmartShape symbol. Its 

primary difference is that the Staff SmartShape symbol is not confined within a rectangle. An example of 
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adding three Staff SmartShape symbols subordinate to a Position SmartShape symbol is illustrated 

below. 

 

To add Staff SmartShape symbols subordinate to a Position SmartShape symbol, Left-Click, (Hold the Left 

Mouse Button Down) Drag, and Drop the Staff Master SmartShape symbol found on the Organization 

Chart Shapes Stencil directly on top of the Position SmartShape symbol. Visio will automatically take 

care of providing a Dynamic Connector SmartShape symbol and gluing the Beginning of the Dynamic 

Connector SmartShape symbol, utilizing Dynamic Glue, to the Position SmartShape symbol, and gluing 

the Ending of the Dynamic Connector SmartShape symbol, utilizing Dynamic Glue, to the Staff 

SmartShape symbol. This process may be repeated for each additional Staff member reporting directly 

to the Position member. 

Adding a Dotted-Line Reporting Indicator 

 

The structure of the Visio 2007 Organization Charting Solution is very rigid and works with the following 

logic. Any Individual in an Organization may have as many individuals reporting to him or her as desired, 

however each individual may ONLY report to one superior person. In other words, One-to-Many going 

DOWN the hierarchy, but One-to-One going UP the hierarchy. Because of this limitation in logic, Visio 

provides a specialized Dynamic Connector SmartShape symbol called a Dotted-line report SmartShape 

symbol. 

By dragging and dropping a Dotted-line report SmartShape symbol onto the Organizational Diagram 

Page and subsequently gluing the beginning and end of the Dotted-line report SmartShape symbol to 

the appropriate Superior and Subordinate SmartShape symbols, the Dotted-line report SmartShape 

symbol can be used to visually indicate the “Dotted Line”, “Alternate”, or “Secondary” reporting 

relationship required in some Organizations. The Process is simply to Left-Click, (Hold the Left Mouse 

Button Down) Drag, and Drop the Dotted-line report Master SmartShape symbol found on the 

Organization Chart Shapes Stencil onto the Visio Diagram Page. Next drag the Begin Point or End Point 

of the Dotted-line report SmartShape symbol to the required Connection Point on the Superior or 

Subordinate SmartShape symbol to establish the necessary glue. Keep in mind that this is totally a 

manual process, and should the diagram need to be recreated, these Dotted-line report SmartShape 

symbols would need to be manually laid in again by the creator of the new or updated diagram. 

Adding a Team Frame Indicator 
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A Team Frame SmartShape symbol is used to encompass all members of a designated group that work 

together, obviously, as a team. This SmartShape Symbol, as illustrated below, may be dropped, then 

relocated, and resized utilizing the SmartShape symbol’s sizing handles to adjust its size to fit around the 

team in question. The Text of the Team Frame SmartShape symbol may be edited to provide a proper 

label for the subject team. 

 

 

Adding Extra Features 

 

Visio additionally provides two Master SmartShape symbols which may be used to add either a Title, or 

a Title and Date to the Organizational Diagram after the diagram has been created, edited, and is ready 

for subsequent printing. 

Adding a Title to the Organizational Diagram 

 

To add a Title Master SmartShape symbol to an Organizational Diagram Left-Click, (Hold the Left Mouse 

Button Down) Drag, and Drop the Title Master SmartShape symbol found on the Organization Chart 

Shapes Stencil to any desired location on the Visio Diagram Page. Using the Left Mouse Button, Double-

Click on any of the text displayed. This action will cause the SmartShape symbol to enter text editing 

mode. The user is free to edit the Company Name and The Department Name in any manner that best 

suits their need. 
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Adding a Title and Date to the Organizational Diagram 

 

To add a Title/Date Master SmartShape symbol to an Organizational Diagram Left-Click, (Hold the Left 

Mouse Button Down) Drag, and Drop the Title/Date Master SmartShape symbol found on the 

Organization Chart Shapes Stencil to any desired location on the Visio Diagram Page. Note that the 

current date will be already set in this SmartShape symbol. Using the Left Mouse Button, Double-Click 

on any of the text displayed. This action will cause the SmartShape symbol to enter text editing mode. 

The user is free to edit the Company Name in any manner that best suits their need. 

 

Adding Pictures to Organizational Diagram SmartShape symbols 

 

All of the Organizational SmartShape symbols that represent members of the Organization (with the 

exception of the Staff SmartShape symbol) are capable of having a Picture associated with them. 

Pictures may be imported from any available source accessible from the user’s network and may be in 

*.emz, *.emf, *.gif, *.jpg, *.png, *.svg, *.svgz, *.tif, *.tiff, *.bmp, *.dib, or *.wmf format. 

To add a picture to an Organizational SmartShape symbol, Right-Click on the selected SmartShape 

symbol and select Insert Picture… from the SmartShape symbol’s context menu.  

 

This action will cause a file dialog to display. Browse to the network or PC Drive, Directory, and File 

where the required picture resides. Select the Picture file. When selected, Left-Click the Open Command 

Button to confirm the choice and close the dialog. The Picture will automatically be resized and will be 

added to the SmartShape symbol as shown below. 
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Editing Manually Created Organizational Diagrams 

 

An old adage states that “there is no such thing as an absolutely correct layout algorithm”. This is 

absolutely true. Often it will be necessary to subtly adjust the organization of the Organizational 

Diagram created with the Visio Tools. This section will provide the user with the tools to edit and adjust 

the Organizational diagram to suit the visual and logical needs of their particular use and their 

organizational requirements. 

Changing the Layout of Subordinates 

 

By default as subordinates are added to the Organizational diagram by dragging and dropping the 

SmartShape symbols on top of the superior SmartShape symbols, Visio lays these new subordinates out 

in a horizontally arranged manner. While this might work in very small organizations, in the vast 

majority, this would rapidly result in a very wide, very shallow layout and would require either 

numerous printed pages taped together or roll-feed plotter paper to print the resultant diagram. 

To overcome this difficulty, Visio, while making no assumptions, provides tools to reconfigure the layout 

to a more compact and visually appealing layout. 

Changing Layout with the Organization Chart Toolbar 

 

As was stated earlier, when the Organizational Diagram was begun, Visio displayed an Organization 

Chart Toolbar floating over the Diagram Page area. 
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This toolbar contains six toolbar buttons which trigger alternate layout commands. From Left to Right 

these toolbar items are: 

• Re-layout 

• Horizontal Layout 

• Vertical Layout 

• Side by Side 

• Move Left 

• Move Right 

Selecting the Re-layout toolbar item retains any previously applied layout methodology and performs an 

analysis of both the collection of all SmartShape symbols on the page and the page size, and adjusts the 

spacing (both vertical and horizontal) of the SmartShape symbols to best fit the page. 

Selecting the Horizontal Layout toolbar item brings up four sub-options for horizontal layout. These are: 

• Center 

• Align Left 

• Align Right 

• Stagger 

The Center sub-option works on all of the subordinates to the selected superior. The Center sub-option 

centers the individual subordinates under the superior as shown below. 

 

The Align Left sub-option works on all of the subordinates to the selected superior. The Align Left sub-

option locates all of the subordinates stacked out to the Right from the Left-most subordinate stacked 

immediately under the superior as shown below. 
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The Align Right sub-option works on all of the subordinates to the selected superior. The Align Right sub-

option locates all of the subordinates stacked out to the Left from the Right-most subordinate stacked 

immediately under the superior as shown below. 

 

The Stagger sub-option works on all of the subordinates to the selected superior. The Stagger sub-

option locates all of the subordinates in a compact horizontal cluster by staggering the subordinates 

above and below each other maintaining their left to right relationship as shown below. 

 

Selecting the Vertical Layout toolbar item brings up four sub-options for vertical layout. These are: 

• Align Left 

• Align Right 

• Staff Align Left 

• Staff Align Right 

The Align Left sub-option works on all of the subordinates to the selected superior. The Align Left sub-

option locates all of the subordinates stacked top to bottom connected on their Left side to the bottom 

of the superior. 
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The Align Right sub-option works on all of the subordinates to the selected superior. The Align Right sub-

option locates all of the subordinates stacked top to bottom connected on their Right side to the bottom 

of the superior. 
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The Staff Align Left sub-option works on all of the subordinates to the selected superior. The Staff Align 

Left sub-option transforms all of the subordinate SmartShape symbols from their previous Master to the 

Staff Master SmartShape symbol instances, and locates all of the subordinates stacked top to bottom 

connected on their Left side to the bottom of the superior. 
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The Staff Align Right sub-option works on all of the subordinates to the selected superior. The Staff Align 

Right sub-option transforms all of the subordinate SmartShape symbols from their previous Master to 

the Staff Master SmartShape symbol instances, and locates all of the subordinates stacked top to 

bottom connected on their Right side to the bottom of the superior. 
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Selecting the Side by Side Layout toolbar item brings up four sub-options for side-by-side layout. These 

are: 

• Single Side 

• Single Top 

• Double Side 

• Double Top 

 

The Single Side sub-option works on all of the subordinates to the selected superior. The Single Side sub-

option locates all of the subordinates stacked side by side in single pairs, top to bottom connected on 

their Left and Right sides to the bottom of the superior. 

 

The Single Top sub-option works on all of the subordinates to the selected superior. The Single Top sub-

option locates all of the subordinates stacked side by side in single pairs, top to bottom connected on 

their Top sides to the bottom of the superior. 
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The Double Side sub-option works on all of the subordinates to the selected superior. The Double Side 

sub-option locates all of the subordinates stacked side by side in double pairs, top to bottom connected 

on their Left and Right sides to the bottom of the superior. 

 

The Double Top sub-option works on all of the subordinates to the selected superior. The Double Top 

sub-option locates all of the subordinates stacked side by side in double pairs, top to bottom connected 

on their Top sides to the bottom of the superior. 
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The Move Left and Move Right options work on the singularly selected subordinate in a group of 

subordinates to a single superior. The Move Left and Move Right options relocate the singularly selected 

subordinate to the left or right within the grouping. The illustration below shows a horizontal center 

layout of five subordinates before a move request is made. 

 

The Move Left option moves the selected subordinate Left within the group. 

 

The Move Right option moves the selected subordinate Right within the group. 

 

 

Changing the Layout with the Re-layout Menu Selection from the Organization Chart Menu 
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Selecting Organization � Chart Re-layout from the Visio Organization Chart Menu performs exactly the 

same function as if it were selected from the toolbar. Selecting the Re-layout menu command retains 

any previously applied layout methodology and performs an analysis of both the collection of all 

SmartShape symbols on the page and the page size, and adjusts the spacing (both vertical and 

horizontal) of the SmartShape symbols to best fit the page. 

 

Changing the Layout with the Arrange Subordinates… Context Menu 

 

Right-Clicking on a desired superior SmartShape symbol displays that symbol’s Context Menu. Among 

the context menu items listed is the Arrange Subordinates… menu item. Selecting the Arrange 

Subordinates… menu item displays the Arrange Subordinates dialog as illustrated below. 

 

The options within the Arrange Subordinates dialog mirror their counterparts from the Organization 

Chart Toolbar. With these options the user can perform all of the Horizontal, Vertical, and Side-by-Side 

layout transformations in exactly the same manner as detailed above. Left-Clicking on the OK Command 

Button accepts the layout change, closes the dialog and applies the transformation to the subordinate 

SmartShape symbols to the selected superior SmartShape symbol. 

Moving Subordinates 

 

The Visio Organization Chart Menu has a pair of menu items dedicated to relocating individual 

subordinate SmartShape symbols within their subordinate groups. The pair of commands are accessed 

by selecting either Organization Chart � Move Subordinates � Left/Up or Organization Chart � Move 

Subordinates � Right/Down from the Visio Organization Chart Menu. These behave exactly as their 

toolbar counterparts do as detailed above. 
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Fitting Organizational SmartShape symbols as a Best Fit to Page 

 

The Visio menu option Organization Chart � Best Fit to Page works exactly as the Re-layout toolbar 

button does. This menu action causes a re-layout of all Organizational Charting SmartShape symbols on 

the page and retains any previously applied layout methodology. It performs an analysis of both the 

collection of all SmartShape symbols on the page and the page size, and adjusts the spacing (both 

vertical and horizontal) of the SmartShape symbols to best fit the page. Note that it DOES NOT take into 

account additional SmartShape symbols such as Team Frames. 

 

Changing a Position Type 

 

Another menu command available from the Context Menu of a selected Organization Chart SmartShape 

symbol is the Change Position Type… command. Right-Click on the selected SmartShape symbol to then 

select this option.  
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This action displays the following dialog. 

 

In the Change Position Type dialog the desired replacement for the selected Organizational Chart 

SmartShape symbol may be selected. When the proper replacement has been selected, Left-Click the OK 

Command Button to confirm the choice, close the dialog, and apply the change to the selected 

SmartShape symbol. 

 

Changing the Spacing between Subordinates 

 

The spacing between the any set of two or more SmartShapes may be modified by choosing 

Organization Chart � Change Spacing… from the Visio Organization Chart Menu. 
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This action causes the Spacing dialog to be displayed. 

 

Note that within the Spacing dialog, the Change Spacing options are (a) Tighter, (b) Looser, and (c) 

Custom (whereby the user can Left-Click on the Values… Command Button. This action will display the 

Custom Spacing Values sub-dialog. 

 

In the Custom Spacing Values sub-dialog the values for horizontal and vertical spacing can be set to a 

very granular level to suit the user’s requirements. 

Within the Spacing dialog, the changes may be applied to (a) the selected shapes, (b) the current page, 

or (c) the entire diagram. Left-Click the OK Command Button to confirm the choices, close the dialog, 

and apply the change to the designated range of SmartShape symbols. 

Creating Synchronized copies across Pages 

 

With large organizations, there is quite literally no way that all of the Organizational Member 

SmartShape symbols will fit on a standard 8.5”X11” or A4 sheet of paper. Therefore it is desirable for 

each Manager or Superior and their collection of subordinates to be displayed on their own page and 
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have a visual reference to the team shown on the original page. This ability to segregate teams onto 

their own pages and yet still keep any changes synchronized between the “roll-up” page and the “team 

page” is native behavior to the Visio Organizational Charting solution. 

The steps to accomplish this advanced behavior are very easy. Begin by looking at the following 

example. 

 

The illustration shows a series of Vice Presidents reporting to the President and CEO. The VP of Sales has 

Directors for US, Asia, and Europe reporting to him or her. The Director of Sales for Europe has German, 

UK, and French Managers reporting to him or her. The UK Manager has four Sub-Managers for England, 

Scotland, Wales, and Northern Ireland reporting up to him or her. The Scottish Sub-Manager has Sales 

Staff for Aberdeenshire, Lothian, and Clydesdale. Finally the Aberdeenshire staff is segregated into sales 

staff for Aberdeen, Fraserburgh, and Peterhead. 

If each of the VP’s were to be filled out to this level the number of individuals simply would not fit on the 

page. Therefore it would be beneficial to segregate the European Sales Team off to their own page. The 

following details the procedure for creating a synchronized copy of this team on a new page. 

Begin by Right-Clicking on the Director of European Sales SmartShape symbol and choosing Create 

Synchronized Copy… from the context menu. 
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This action will display the Create Synchronized Copy dialog. By Default, the selection of Create a 

synchronized copy on New page is selected. Since the diagram thus far only has one page, the first page, 

established within it, this is the logical choice. If the diagram already had multiple pages in it, the user 

would be free to select any existing page to create the synchronized copy and duplicate the team to that 

page. Notice, also, the check box for Hide subordinates on original page. This check box should be 

clicked and checked to ensure that the team is “rolled up” under this Director as displayed on the 

original first page. 

 

When the OK Command Button is Left-Clicked, Visio confirms the action request, closes the dialog, rolls 

the team up on the original page, creates a new page, and displays the team on the new page as shown 

below. 
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By clicking on the Page-1 Page tab at the bottom of the diagramming window, the user returns to Page-1 

and notes that the team is now displayed as “rolled up” on the original page. This is designated by the 

illustration of the “stack” of Position SmartShape symbols, actually just a modification of the singular 

Director SmartShape symbol, on the page. 

 

Returning to the newly created page by clicking on the “Page-2” page tab, the user can now work with 

more detail on the synchronized copy. Here, the creator of the diagram has added a new Position 

SmartShape symbol reporting to the French Sales Manager. The new Sub-Manager for Paris was added 

in exactly the same manner all subordinates are added under superiors: drag and drop on top of the 

superior. 
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Returning to the first page by Left-Clicking on the “Page-1” tab in the collection of page tabs at the 

bottom of the diagramming area, the user then Right-Clicks on the Director for Europe Sales and 

chooses the Expand Subordinates context menu item. The team expands and is shown with the new 

changes in place on the original page. 

So as has been demonstrated, creating a synchronized copy is very fast and easy to accomplish. 

Whenever a change is made to the details of the team on any given page, whether the original page or 

the synchronized new page, the diagram details and organizational structure remain exactly the same. 

At any time the user can opt to show or hide subordinates for any superior as desired. 

 

While it is not difficult to traverse between the top-level page and a subordinate detail page utilizing the 

page tabs at the bottom of the diagramming area, it would be beneficial and far more productive to 

provide a navigational shortcut from the SmartShape symbol on the original page to the details for that 

individual and his or her team. This can be accomplished one or both of two methods; hyperlinks and 

double-click actions. This section will step the user through both of these methods. 

The First method is establishing a hyperlink. Left-Click, to select, the SmartShape symbol to be used as 

the starting point of the hyperlink. From the Visio Insert Menu, choose Insert Hyperlinks… 
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This action will display the Hyperlinks dialog. Left-Click on the Browse… Command Button directly across 

from the Sub-address Text Box. In the listing choose “Page-2” as the target of the hyperlink (remember 

that in this case the expanded team resides on Page-2 of the diagram). Fill in the text for the verbiage 

for the hyperlink in the Description Text Box. In this case the user has added the text “European Sales”. 

Left-Click the OK Command Button to confirm the request to create a Hyperlink, close the dialog and 

complete the action. 

 

The Second method is establishing a Double-Click action so that when the viewer of the diagram uses 

the Left Mouse button and Double-Clicks on the face of the Director of European Sales SmartShape 

symbol, the user will jump directly to the expanded team on Page-2. Left-Click, to select, the 

SmartShape symbol to be used as the source for the Double-Click action. From the Visio Format Menu, 

choose Insert Behavior… 

 

This action will cause the Behavior dialog to display. In the Behavior dialog, Left-Click on the Double-

Click tab at the top of the dialog. On the Double-Click tab look toward the very bottom of the dialog and 
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locate the Go to page Radio Button. Left-Click to select the Go to page Radio Button and use the drop-

down listing to select the Page-2 item. When these tasks have been completed, Left-Click the OK 

Command button to confirm the choices, close the dialog and complete the creation of the double-click 

action for this SmartShape symbol. 

 

After this action has been completed, at any future time the user can either Right-Click and select the 

“European Sales” hyperlink, or simply use the Left Mouse Button and Double-Click to navigate to the 

detail page (in this case Page-2) for that director’s team. 
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In best practice, the same hyperlinks, behaviors, and actions would be established on the Page-2 

representation of the Director’s SmartShape symbol to create Hyperlinks and Double-Click actions to 

return to the original page (in this case Page-1). 

Working with Synchronized SmartShape Symbols 

 

Many times users of Visio diagrams tend to think of the diagrams as static images, as if they were 

printed on a sheet of paper. However, while in the Visio environment, the diagrams are actually vibrant, 

alive, interactive documents. We have shown above how adding hyperlinks and double-click actions 

assists in navigating around multi-page diagrams. Note also that at any time the viewer of the diagram 

can expand or collapse the visualization of any team within the Visio Organizational Diagram. 

Expanding Subordinates 

 

To expand Subordinates under a superior, simply Right-Click on the superior SmartShape symbol and 

choose Expand Subordinates. Alternately, Left-Click to select the desired superior SmartShape symbol, 

and from the Visio Organization Chart menu, choose Organization Chart � Show Subordinates. 

Collapsing Subordinates 

 

To collapse Subordinates under a superior, simply Right-Click on the superior SmartShape symbol and 

choose Hide Subordinates. Alternately, Left-Click to select the desired superior SmartShape symbol, and 

from the Visio Organization Chart menu, choose Organization Chart � Hide Subordinates. 

Adding Divider Lines in Organizational SmartShape Symbols 

 

By default the Name of the person and their title are shown stacked directly on top of each other on the 

face of the SmartShape symbol. This can make it more difficult to read in a situation where there are 

hundreds of employees in the organization. Visio provides a mechanism for adding or removing a 

dividing line between the Name and the Title on an Organizational Charting SmartShape symbol. 

To add a Divider Line between the Name and Title of an Organizational Charting SmartShape symbol, 

Right-Click on the SmartShape symbol and choose Show Divider Line from the Context Menu. 
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To remove a Divider Line between the Name and Title of an Organizational Charting SmartShape symbol, 

Right-Click on the SmartShape symbol and choose Hide Divider Line from the Context Menu. 

 

 

Organizational Diagram Options 

There are a large number of options available to the user of Visio Organizational Charting Diagrams. This 

section will detail those options. To access the options choose Organization Chart � Options… from the 

Visio Organization Chart menu. 
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This action will display the Options dialog with the Options dialog open to the Options tab as its focus. 

 

 

Options 

 

The available Options on the Options tab are the Width and Height of the SmartShape symbol, whether 

or not to show pictures on the face of the SmartShape symbol, Whether or not to show the divider line 

between the Name and Title fields on the face of the SmartShape symbol, whether or not to show 

drawing tips when available, and whether or not to use these option settings for new organization 

charts 
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Shape Display Width 

 

The Shape Display Width has both a scroll arrow set and a direct text entry. Modifying the value in this 

field changes the width of all of the Organizational Charting SmartShape symbols in the current diagram. 

 

Shape Display Height 

 

The Shape Display Height has both a scroll arrow set and a direct text entry. Modifying the value in this 

field changes the height of all of the Organizational Charting SmartShape symbols in the current 

diagram. 

 

Shape Display Show Pictures 

 

The Shape Display Show Pictures is a Check Box. Checking or un-checking this box determines whether 

or not pictures can be displayed on ANY of the Organizational Charting SmartShape symbols. If enabled, 

only those who have explicitly added a picture will display them. If disabled, NONE of the Organizational 

Charting SmartShape symbols will be able to accept the addition of pictures. 

 

Shape Display Show Divider 

 

The Shape Display Show Dividers is a Check Box. Checking or un-checking this box determines whether 

or not a dividing line can be displayed on ANY of the Organizational Charting SmartShape symbols. If 

enabled, only those who have explicitly added the dividing line will display the line. If disabled, NONE of 

the Organizational Charting SmartShape symbols will be able to accept the addition of the dividing line. 

 

General Show Drawing Tips When Available 

 

The General Show drawing tips when available is a Check Box. Checking or un-checking this box 

determines whether or not drawing tips can be displayed where they are available within the 

Organizational Charting Solution. If enabled, drawing tips will be displayed if and when they are 

available. If disabled, drawing tips will NOT be displayed regardless of their availability. 
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General Use These Options for New Organizational Diagrams 

 

The General Use these options for new Organizational diagrams is a Check Box. Checking or un-checking 

this box determines whether or not new Organizational diagrams based upon the Organizational 

Charting Solution and Template will use the settings configured in this dialog. If enabled, new 

Organizational Charting Diagrams will use the settings as configured in this dialog. If disabled, new 

Organizational Charting Diagrams will use the default settings provided as part of the Organizational 

Charting Solution and Template. 

 

Fields 

 

The Fields Tab of the Options Dialog includes the following options: Block 1 Field Display Choices, Blocks 

2 through 5 Field Choice, and the Restore Defaults option. 

 

 

Block 1 

 

The Block 1 area controls the display field(s) for the main text block for the Organizational Charting 

SmartShape symbols. The user can configure the display of the Name, Title, Department, E-mail, and 

Telephone fields. Each item checked will display in the center text block, each unchecked item will not 

display. 
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Block(s) 2 through 5 

 

For each of the Block 2, Block 3, Block 4, and Block 5, a drop-down list of fields to be displayed in the 

respective area as shown on the diagram within the dialog is available. For each additional field that is 

desired to be displayed in each of the blocks, choose the desired field. 

 

Restoring Defaults 

 

The Restore Defaults Command Button, when Left-Clicked, will reset the field information back to the 

default state, showing only the Name and Title as entered in the Shape Data fields of the SmartShape 

symbol. 

 

Text 

 

The Text Tab of the Options dialog contains options to set the Font, Font Size, and Font Color as well as 

the bolding and italicization for the displayed fields. 

 

 

Fields 

 

The Fields provides a listing of the currently displayed fields associated with the SmartShape symbol. In 

order to change any of the characteristics of the text of any of the fields, the particular field must be 

selected. For example, to change the Font and point size and color of the text displaying the employee’s 
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name, the Name field would need to be selected in this drop-down listing. This process would need to 

be repeated for each desired field. 

 

Font 

 

Using the Font drop-down list, the user may select and apply the given Font Type to be associated with 

the selected field. 

 

Size 

 

Using the Size drop-down list, the user may select and apply the given Font Size (in Points) to be 

associated with the selected field. 

 

Color 

 

Using the Color drop-down list, the user may select and apply the given Font Color (among the first 24 

indexed colors) to be associated with the selected field. 

 

Style Bold 

 

Using the Bold Check Box, the user may select and apply whether the given Font to be associated with 

the selected field is or is not bolded. 

 

Style Italic 

 

Using the Italic Check Box, the user may select and apply whether the given Font to be associated with 

the selected field is or is not italicized. 

 

When all Options have been set in the Options Dialog, Left-Click on the OK Command Button to confirm 

the desired Option Configuration settings, close the dialog, and apply the changes. 
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02 - Organizational Diagrams Created Utilizing the Organization Chart Wizard 

 

Having progressed through using the Visio Organizational Charting Solution, this section will next detail 

how to utilize the Organization Chart Wizard to (a) utilize data from an external data source, and (b) 

automate the process for completely generating an Organizational Diagram. 

 

Creating a New Organizational Diagram with the Organization Chart Wizard 

 

There are actually two parallel methodologies for beginning the creating a new Organizational Diagram 

utilizing the Organization Chart Wizard. Like creating a new Organizational Diagram manually, the 

process can be instigated by either selecting from the Getting Started Task Pane, or from the Visio File 

menu. 

 

Getting Started Methodology 

 

While the Getting Started Screen is active in Visio 2007 (both Standard and Professional editions), look 

at the Template Categories at the Left Side of the Getting Started set of Task Panes. Left-Click to select 

the Category listed as Business. This action will display the Business Category and its store of available 

Visio Business Templates. 

Left-Click on the Organization Chart Wizard Icon in either the Featured Templates area or the Other 

Templates area of the Business Category Page of the Getting Started Task Area. Next, Left-Click to 

choose either the US units or the Metric Radio Button, depending on the desired target output. Finally, 

Left-Click on the Create Command Button to confirm the choices and create the new blank 

Organizational Diagram. This action will also, as soon as the Organization Chart Diagram environment is 

ready, display the first screen of the Organization Chart Wizard. 

 

File Menu Methodology 

 

Whether or not the Getting Started Screen is active in Visio 2007 (both Standard and Professional 

editions), Left-Click on the File Menu in the Visio 2007 Menu Sets at the top of the Visio environment.  

Choose File � New � Business � Organization Chart Wizard (US units) from the Visio File Menu. 
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Creating a New Organizational Diagram with the Import Organization Data… from the 

Organization Chart Menu 

 

When a new Organizational Diagram is begun using the Organization Chart Template (and NOT the 

Organization Chart Wizard Template), or if the creator of the Organization Chart opted to cancel out of 

the Wizard (having based the diagram on the Organization Chart Wizard Template), the user still has the 

ability to launch and display the opening screen of the Organization Chart Wizard by choosing 

Organization Chart � Import Organization Data… from the Visio Organization Chart menu. 

 

The Wizard 

 

Any of the above actions will display the first screen of the Organization Chart Wizard. Screen 1 of the 

Wizard will look similar to the Illustration below. 

 

Screen 1 

 

 

The first screen of the Organization Chart Wizard prompts the creator to answer one question. “I want 

to create my organization chart from:”. The creator can opt to either create the Organizational Diagram 

from “information that’s already stored in a file or database”, or “Information that I enter using the 

wizard”. 

In the case of this example, the creator will opt to utilize an Excel Spreadsheet containing the 

organizational structure. The structure of this spreadsheet will be discussed shortly. 

From Data Stored in an External Data Source 

 



Visio 2007 Organizational Diagramming Page 46 

 

The first option, From data stored in an external data source, will later prompt the creator to select a 

particular data file. 

 

From Data Manually Entered in the Wizard 

 

The second option, From data manually entered in the wizard, will solicit the creator to either open 

Microsoft Office Excel (to create a spreadsheet of data), open Windows Notepad (to create a 

deliminated text file), or browse for a file of either of these two types. The creator will then enter the 

data into one of these two formats, save and close the newly created data source file, then return to the 

wizard. 

 

Left-Click the Next > Command Button to advance to the Second Screen of the Organization Chart 

Wizard. 

 

Screen 2 

 

The second screen then asks the creator to select the type of data source which will be used to import in 

the structure of the organization in question. 

 

These data sources can be any of the following: 

• A Microsoft Exchange Server directory 

• A Text file (in comma, space, or character deliminated format) 

• An OrgPlus file (which has already been converted to text format and saved as such) 

• A Microsoft Office Excel Workbook spreadsheet 

• Any ODBC-compliant data source 
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Data Sources 

A Microsoft Exchange Server directory 

 

A Microsoft Exchange Server directory may be utilized as a valid data source. However, the Organization 

Chart Wizard needs to have two discrete fields of information to properly establish the hierarchy of the 

organization. These fields equate to (a) “Who am I”, and (b) “Who do I report to”. Many 

implementations of Exchange Server have the employee’s name, and their E-mail alias, and possibly 

their telephone extension and/or office/cubicle number; however, they rarely seem to have the 

Manager’s name listed within the Exchange Server directory. 

The creator can work with the Exchange administrator to add this vital field, or opt to utilize another 

data source type. 

A Text file (cdf, sdf, or chdf- delimited file) 

 

A simple text file can be utilized to hold the source data. This text file can be either Comma, Space, or 

Character deliminated. The structure of these files would be similar to the examples below: 

Comma Deliminated 

Name, Title, Manager, Department, Telephone, E-mail, Master_Shape, Office Number 

Jossef Goldberg,President & CEO,,Office of the President,555-0100,jossef@championzone.net,,17102 

Suzan Fine,Executive Assistant,Jossef Goldberg,Office of the President,555-0101,suzan@championzone.net,Assistant,17104 

Clair Hector,COO,Jossef Goldberg,Operations,555-0102,clair@championzone.net,,17106 

Space Deliminated 

Name Title Manager Department Telephone E-mail Master_Shape Office_Number 

Jossef_Goldberg President_&_CEO  Office_of_the_President 555-0100 jossef@championzone.net  17102 

Suzan_Fine Executive_Assistant Jossef_Goldberg Office_of_the_President 555-0101 suzan@championzone.net Assistant 17104 

Clair_Hector COO Jossef_Goldberg Operations 555-0102 clair@championzone.net  17106 

Character Deliminated 

Name# Title# Manager# Department# Telephone# E-mail# Master_Shape# Office Number 

Jossef Goldberg#President & CEO##Office of the President#555-0100#jossef@championzone.net##17102 

Suzan Fine#Executive Assistant#Jossef#Goldberg#Office of the President#555-0101#suzan@championzone.net#Assistant#17104 

Clair Hector#COO,Jossef Goldberg#Operations#555-0102##clair@championzone.net##17106 
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A Microsoft Office Excel Workbook file 

 

A Microsoft Office Excel Workbook (spreadsheet) may be utilized as a valid data source. The only caveat 

is that Row “1”, the first row, MUST be the headers of the columns of information presented below. 

Below is shown a portion of a valid Excel spreadsheet to be used as a data source. 

 

The header titles are shown in row 1. The Header Titles can be anything the creator desires. They will be 

mapped in the Wizard to the “Who am I”, and the “Who do I report to” fields. 

The data in Column A “Employee”, must be in exactly the same format as the data in Column C 

“Reports_To” in order for the Wizard to understand the hierarchal relationship. In other words, if the 

name in the Employee column is “Jossef Goldberg”, then the name in the Reports_To column must also 

be “Jossef Goldberg”, not “Joe Goldberg”, or “Joseph Goldberg”. An exact match is necessary for the 

structuring algorithm to work properly. 

 

An Org Plus file (saved in .TXT format) 

 

An OrgPlus file may be used as a valid data input source. However, the OrgPlus file must be already 

saved in OrgPlus’ text format file structure PRIOR to attempting the import of the data into Visio. 

 

An ODBC-Compliant Data Source 

 

Additionally, ANY ODBC-compliant data source may be used as a data input source for the Organization 

Chart Wizard. The only caveat is that the ODBC-compliant data source must also contain in the same 

table or view or query, the two data fields for “Who am I”, and “Who do I report to”. 
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This means that a Microsoft Office Access database, a Microsoft SQL database, a PeopleSoft database, 

an Oracle database, or any other data base (OLEDB or ODBC-compliant) is valid as an input source. 

Left-Click the Next > Command Button to advance to the Third Screen of the Organization Chart Wizard. 

 

Screen 3 

 

The third screen solicits the user to both enter the complete path, and file name, for the input source 

file, or Left-Click on the Browse… Command Button to display a Windows File Selection dialog 

 

 

If the Browse… function is utilized, the creator will need to Left-Click on the Open Command Button to 

confirm the selection of the file and return the complete path and filename to the Organization Chart 

Wizard. 
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NOTE: After the first usage of the Wizard, the Wizard remembers this file and path as well as all other 

settings in the Wizard. This is because in Visio, Organization Chart Diagrams are referred to as 

“disposable” diagrams. This DOES NOT mean that they are any less important than any other diagram 

type. It is simply that it is so quick and easy to generate an Organizational Chart Diagram, that if the data 

changes, a new diagram can be generated on the fly. Therefore, if the creator has already answered the 

questions in the Wizard the first time through, why should he or she be required to answer them again? 

Visio remembers all the previous run’s settings, and therefore the next time the creator wishes to 

generate a new Organization Chart Diagram from the same data source, he or she simply needs to 

repetitively click the Next Command Button (and finally the Finish Command Button) to rapidly generate 

the diagram. The creator simply Left-Clicks “Next”, “Next”, “Next”, “Next”, “Next”, “Next”, and “Finish”. 

Locating the data file 

 

As stated before, the creator has full control to Browse for the data source file by Left-Clicking on the 

Browse… Command Button. The source file may be either on the creator’s own local PC or on any PC or 

Server attached to the network that the creator can access. 

 

Specifying the language 

 

Though rarely necessary to alter, the creator can specify an alternate language set for the data source to 

be input. Therefore Simplified Chinese, Kanji, Cyrillic, etc. may be specified as necessary. 

Left-Click the Next > Command Button to advance to the Fourth Screen of the Organization Chart 

Wizard. 

 

Screen 4 

 

The Fourth screen is where the mapping between the source data fields, and the fields that the Wizard 

needs, takes place. 
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Data Fields 

 

There two mandatory and one optional data fields are; Name, and Reports to, as well as First name 

(optional). 

 

Name 

 

The Name field equates to the Employee Name within the organization. Select the data field from the 

data source that references the Employee Name. 

 

Reports to 

 

The Reports to field equates to the Manager or Supervisor Name within the organization. Select the data 

field from the data source that references the Manager or Supervisor Name. 

 

First name (optional) 

 

The optional First name field may be used in conjunction with the Name field if, in the data source, 

these two items are in separate fields. If, in the data source, the First Name field contains the value 

“Jossef” and the Last Name field contains the value “Goldberg”. Then in the Wizard the Name field 

would be mapped to “Last Name” and the optional First Name field would be mapped to “First Name”. 

The Reports to field in the Wizard would map to the “Manager field in the data source. 
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Left-Click the Next > Command Button to advance to the Fifth Screen of the Organization Chart Wizard. 

 

Screen 5 

 

The fifth screen in the Wizard is where the fields of data to be displayed on the face of the SmartShape 

symbol will be configured. 

 

 

Displayed Fields 

 

The data file columns listing contains all of the data field columns as discovered by the Wizard from the 

data source. The Displayed fields listing contains the list of fields to be displayed, and in which order, on 

the face of the SmartShape symbol. 

By utilizing the Add > and the Remove < Command Buttons, items from the Left and Right columns can 

be transferred back and forth. 

By utilizing the Up and Down Command Buttons, items in the Right Column, those to be displayed on 

the face of the SmartShape symbol, can be re-ordered to suit the requirements of the creator of the 

new Organizational Chart. 

 

Adding 

 

To add a data item to the display on the face of the SmartShape, Left-Click the item in the Left Column, 

then Left-Click the Add > Command Button. 
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Removing 

 

To remove a data item from the display on the face of the SmartShape, Left-Click the item in the Right 

Column, then Left-Click the < Remove Command Button. 

 

Reordering 

 

To display any item in the Displayed fields listing higher in “Top-to-Bottom” order, Left-Click the desired 

item in the Right Column and then Left-Click the Up Command Button. To display any item in the 

Displayed fields listing lower in “Top-to-Bottom” order, Left-Click the desired item in the Right Column 

and then Left-Click the Down Command Button. 

 

Left-Click the Next > Command Button to advance to the Sixth Screen of the Organization Chart Wizard. 

 

Screen 6 

 

The Sixth screen of the Organization Chart Wizard contains options to include or exclude data fields 

from the data source as Shape Data attached to the SmartShape symbol. 

 

 

Shape Data Fields 
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The data file columns listing contains all of the data field columns as discovered by the Wizard from the 

data source. The Shape Data fields listing contains the list of fields to be attached to the SmartShape 

symbol as Shape Data items. 

By utilizing the Add > and the Remove < Command Buttons, items from the Left and Right columns can 

be transferred back and forth. 

 

Adding 

 

To add a data item to the Shape Data items attached to the SmartShape, Left-Click the item in the Left 

Column, then Left-Click the Add > Command Button. 

 

Removing 

To remove a data item from the Shape Data items attached to the SmartShape, Left-Click the item in the 

Right Column, then Left-Click the < Remove Command Button. 

 

Left-Click the Next > Command Button to advance to the Seventh and Final Screen of the Organization 

Chart Wizard. 

 

Screen 7 

 

The Seventh and Final screen of the Organization Chart Wizard contains options controlling the 

breakdown of the Hierarchy of the diagram as well as options for hyperlinking and synchronization. 
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Breaking Down the Organization by Hierarchy 

 

The creator of the Organizational Chart can opt to either allow the Visio Organization Chart Wizard make 

its own decisions as to how the Organizational Structure should be broken down, or, alternately, 

exercise manual control over the breakdown structure. 

User Specified Breakdown 

 

To manually specify the breakdown points for breaking out teams to their own individual pages, ensure 

that the “I want to specify how much of my organization to display on each page” radio button is 

selected. 

 

Wizard Calculated Breakdown 

 

To allow the Visio Organization Chart Wizard to specify the breakdown points for breaking out teams to 

their own individual pages, ensure that the “I want the wizard to automatically break my organization 

chart across pages” radio button is selected. 

 

Utilizing the optional Name at top of Page drop-down listing the creator can either let the Wizard place 

the name of the top-level data entry as the highest ranking person and build the hierarchy from there 

(this is the default), or opt to manually select the highest ranking person to begin the hierarchy on the 

first page of the completed Organization Chart Diagram. 

 

Hyperlinks 

 

The “Hyperlink employee shapes across pages” check box allows the creator to determine if the Wizard 

should automatically establish hyperlinks between superiors on one page and their expanded teams on 

subsequent pages, by checking, or un-checking the Check Box. 

 

Synchronization 

 

The “Synchronize employee shapes across pages” check box allows the creator to determine if the 

Wizard should automatically maintain the synchronization between pages for rolled up teams on one 

page and their expanded teams on subsequent pages, by checking, or un-checking the Check Box. 
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Left-Click the Finish Command Button to confirm all of the choices made in the Organization Chart 

Wizard, close the Wizard, and complete the building of the entire Organization Chart Diagram. 

When complete, the wizard will close, then display two progress dialogs as it proceeds to generate the 

organizational hierarchy. Upon successful completion of all of the Wizard’s tasks, the creator/user will 

be confronted with the final page of the diagram.  

 

At any time thereafter, the user can utilize the Page Tabs and Page VCR-style controls to navigate back 

to the first page (“management roll-up”) of the Visio Organization Chart Diagram. 
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03 - Best Practice Techniques for Organizational Diagrams 

 

This section provides the user of Visio Organization Chart Diagrams some “Best Practice” techniques for 

working with Organizational Diagrams. This section will discuss and detail utilizing Background Pages and 

when to create Background Pages. This Section will discuss the insertion and placement of Corporate 

Logos and Title Block and Border information. This section will also detail how to alter the hyperlinks 

generated by the Organization Chart Wizard as well as the Page Names to make navigation through the 

Organization Chart Diagram even more intuitive to the user / viewer. 

This section will also address the issues of adding additional data fields to SmartShape symbols in order 

to track even more data about each employee. This section will also address the issue of the new Visio 

2007 Themes to provide a standardized and highly professional “Look and Feel” to the final Visio 

Organization Chart Diagram. 

 

Background Pages 

 

One of the frustrations that users of Visio Organizational Chart Diagrams experience is that once they 

have learned about the power of Background Pages, they create a Background Page and then struggle 

through applying that background to each of the many foreground pages in the diagram. The key to 

overcoming the frustration and intensive labor of setting page properties numerous times is to create 

the Background Page PRIOR to running the Visio Organization Chart Wizard. 

Here are the steps: 

1. Begin a new Visio Organizational Chart Diagram based on the Visio Organization Chart Wizard 

Template or the Visio Organization Chart Template. 

2. If the Visio Organization Chart Wizard launches, CANCEL the Wizard by Left-Clicking on the 

Cancel Command Button on the First Screen of the Wizard. 

3. Create a Background Page. Choose Insert � New Page from the Visio Insert Menu. In the Page 

Setup Dialog, on the Page Properties Tab Left-Click on the Background Radio Button for the Type 

Field. If desired, provide a preferred name for the background page, or accept the default name 

of “Background-1”. Left-Click the OK Command Button to confirm the choices and close the 

dialog. 

4. Add all required elements to the Background Page. 

5. Return to the First Page (Page-1) of the Diagram. 

6. Choose File Page Setup… from the Visio File Menu. 

7. In the Page Setup Dialog, on the Page Properties Tab, in the Background drop-down listing, 

choose the newly created Background page (Background-1) as the assigned background page for 
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this foreground page. Left-Click the OK Command Button to confirm the choices and close the 

dialog. 

8. Restart the Organization Chart Wizard by choosing Organization Chart � Import Organization 

Data… from the Visio Organization Chart Menu. 

9. Continue through all Screens of the Wizard. 

As the Wizard builds the pages of the Diagram, Visio will automatically assign the designated 

Background page to each of the new Foreground pages. 

If a Visio Organization Chart Diagram has already been created, and that diagram does not already 

contain a Background, the creator can quickly add a Background to a page by dragging a background 

from the Visio Backgrounds Stencil. 

 

Upon dropping the desired background, Visio will create the Background Page and assign it to the 

current Foreground Page. 
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To then apply the Background page to every subsequent Foreground page, choose File � Page Setup… 

from the Visio File Menu. 

 

In the Page Setup Dialog, on the Page Properties Tab, in the Background drop-down listing, choose the 

newly created Background page (Background-1) as the assigned background page for this foreground 

page. Left-Click the OK Command Button to confirm the choices and close the dialog. 

 

This process of assigning a Background page to each and every Foreground page will need to be 

accomplished once for each Foreground Page. Ensure that the desired Foreground Page is active prior to 

going through the process of assigning the Background page. 

Remember that once a Background page has been created, additional “static” elements such as Title 

Blocks, Borders, and Corporate Logos may be added to the Background Page and those elements will be 

visible to each and every Foreground page with that Background page assigned to it. 

 

Corporate Logos 
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Adding a Corporate Logo to the Background page ensures that the Logo is visible by all Foreground 

pages. It has the additional benefit of conserving Visio Diagram file size as well. Rather than adding the 

corporate logo to each and every Foreground page, and thereby increasing the file size by, say, 45Kbytes 

for each instance, adding it only once to the Background dramatically conserves file size while still 

providing the benefits of seeing the logo on every page, and in exactly the same position on every 

Foreground page. 

 

Adjusting Hyperlink References 

 

When the Visio Organization Chart Wizard generates the Hyperlinks between a superior on a 

“management team” first page, and the individual Manager’s team’s on their unique subsequent pages, 

the Wizard takes a series of default actions. These actions and assumptions include: 

1. The pages that the Wizard generates have the default page names, i.e. “Page-1”, “Page-2”, 

“Page-3”, etc. 

2. The SmartShape symbols are indexed by the order that they are dropped on the Page (this is, in 

the case of the Wizard generating them, absolutely random, by design) and as such, individual 

SmartShape symbols on the “management team” page have indexes like “Sheet.21”, 

“Sheet.126”, “Sheet.15”, etc. The Referenced SmartShape symbol for the unique Manager on 

his or her own page will always have that particular manager as “Sheet.1” on their own page. 

3. The Hyperlink reference always includes a pan and zoom command to place the subject 

SmartShape symbol at the center of the view for the target of the Hyperlink. 

This causes the user to have the target page skewed, and zoomed at a magnification that is less than 

conducive to utilizing Visio’s Full Screen Viewing Mode (accessed by pressing the F5 key). 

It would be far better to have each page name refer to the Manager’s name associated with that 

particular page, and have the Hyperlinks reference the Manager by name, and have the Hyperlink jump 

go to the target page with the full page in the center of view. 

As can be seen below, when the mouse cursor is floated over Connie Waite’s SmartShape symbol on the 

“management team” first page, the Hyperlink reference is to  “Page-11/Sheet.1”. Hardly helpful. 
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To correct this difficulty, Left-Click to select the SmartShape symbol and then choose Insert � 

Hyperlinks… from the Visio Insert menu. 

 

This action will display the Hyperlinks dialog, with the Visio Organization Chart Wizard-created hyperlink 

already highlighted. 

 

Left-Click on the Browse… Command Button directly opposite the Sub-address Text Box. The Sub-

address is used since the hyperlink is referring to a location within the current Visio Diagram. 

This assumes that the creator has already renamed each of the Foreground Pages to have the Page 

Name be the same as the Manager’s name as the top of that team on that page. In other words, “Sheet-

11” should be renamed to “Connie Waite”. 

Modify the settings such that the Sub Address refers to the “Connie Waite” page. Modify the settings 

such that the Zoom reference is to the full Page. 
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Upon returning to the Hyperlinks dialog, the Address should contain the text string “?zoom=-1”, which 

means that the zoom is to the full page. The Sub-address should contain the text string “Connie Waite”, 

which is the name of the page that the hyperlink should traverse to. The Description should then be 

filled in, in the Description Text Box, to let the user know that the Hyperlink will take them to Connie’s 

team page. The text string would read something like “Connie Waite’s Team”. 

 

When these edits have been accomplished, the Hyperlinks dialog should look similar to that shown 

above. Left-Click on the OK Command Button to confirm the changes and close the dialog. 

Now when the user floats the mouse cursor over the Connie Waite SmartShape symbol, the hyperlink 

prompt text will assist the user in understanding where they will be transported to. 

 

Obviously, this tack would need to be accomplished for each hyperlink in the diagram, and furthermore, 

would need to be accomplished for both ends of the Hyperlink. In other words, the edited hyperlink 

would navigate properly to the full page view for Connie Waite, and when the user Right-Clicks on the 

Connie Waite SmartShape symbol on her individual team page, the Hyperlink should navigate back to 

the “management team” page in full page zoom, with an appropriate Description to assist the user in 

understanding the return Hyperlink. 
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Adding Additional Shape Data to Organizational Diagram SmartShape symbols 

 

Each Visio Organization Chart SmartShape symbol designed to represent an employee has a series of 

Shape Data fields already designed into it. These are: 

• Department 

• Telephone 

• Name 

• Title 

• E-mail 

These were determined by the creators of the Visio Organization Charting Solution from within, first, 

Visio Corporation, and secondarily, Microsoft Corporation after the acquisition of Visio by Microsoft. 

For many applications of the Organization Charting Solution these fields may be totally adequate. 

However, it may also be necessary to track more information that these fields provide. For example, the 

employee’s date of hire, the employee’s date of last performance review, the employee’s latest 

performance rating, whether or not they have completed certain required training seminars, etc. 

At any time it is possible to add additional Shape Data fields to any Visio SmartShape symbol. This is 

actually a very easy process. If the user has ever created a simple Microsoft Office Access Database 

Table, the process should feel almost identical. 

One concept and one setting should be covered prior to undertaking this modification, however. Firstly 

the user needs to understand that each SmartShape symbol on the Visio Diagram Page is an INSTANCE 

of a Master SmartShape symbol. Whenever a Master SmartShape symbol is dragged and dropped from 

an external Visio Stencil, the first thing that Visio does, is make a copy of that Master SmartShape 

symbol on the current Diagram’s own Local Document Stencil. Every Visio Diagram has its own Local 

Stencil. Any modification made to the Local Master SmartShape symbol will be propagated to every 

Instance of that Local Master SmartShape symbol. By default, the Local Document Stencil is always NOT 

displayed in the collection of Stencils in the Shapes Pane of the Visio environment. The Local Document 

Stencil, however, can be opened at any time by choosing File � Shapes � Show Document Stencil from 

the Visio File menu. 

In order to maximize the power of the Define Shape Data dialog for adding more Shape Data fields to a 

SmartShape symbol, one setting should be properly set in the Visio Options dialog. 

Choose Tools � Options… from the Visio Tools Menu. In the Options Dialog, Left-Click on the Advanced 

Tab to activate the advanced options. On the Advanced Tab, in the Advanced Options area, ensure that 

the “Run in developer mode” Check Box option is checked. When this has been accomplished, Left-Click 

the OK Command Button to confirm your choices and close the dialog. This action will ensure that every 

available option is displayed in the Define Shape Data dialog. 
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Though it would be equally as easy to add additional Shape Data to any singular SmartShape symbol, it 

makes far more sense to modify the local Master SmartShape symbol. This will ensure that the 

modifications that are made need only be made once, and then every Instance of that Master will have 

those new Shape Data fields incorporated into them. 

Here is the process for adding new Shape Data fields to a Local Master SmartShape symbol. 

Begin by opening the Local Document Stencil. This is accomplished by choosing File � Shapes � Show 

Document Stencil from the Visio File menu. 

 

This action will cause the Local Document Stencil to be added to the collection of open Stencils in the 

Visio Environment for the Organization Chart Solution. 
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Next, Right-Click on a Local Master SmartShape symbol, for example the Position Master SmartShape 

symbol, and choose Edit Master � Edit Master Shape from the Position Master SmartShape symbol’s 

context menu. 

 

This action will open an entirely new window in the Visio Environment, a Master Editing Window. The 

Position Master SmartShape symbol will be displayed in this window. 
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With the Local Master Editing Window open, Right-Click on the Process Master SmartShape symbol and 

choose Data � Shape Data… from the Process Master SmartShape symbol’s context menu. 

 

This action will display the Shape Data dialog for the Process Master SmartShape symbol. 
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Next, Left-Click on the Define… Command Button at the bottom of the Shape Data dialog. This action 

will display the Define Shape Data dialog. 

 

To add a new Shape Data field to the Process Master SmartShape symbol, Left-Click the New Command 

Button at the bottom of the dialog. 
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To add a new Shape Data field for the Date of Hire for the Position Master SmartShape symbol, 

complete the Label, the Name, the Type, the Format, and the Prompt fields as shown below. 

Note that the Label field is a string and CAN contain spaces, however the Name field is the physical 

name of the field, and as is typical of programming logic, this field cannot contain any spaces. The 

choices would be to use things like “HireDate” or “Hire_Date” for this entry. Since this is a Hire Date, the 

type field would be selected as a Date Data Type. The Format is any acceptable format chosen from the 

drop-down listing of date format types. The Prompt is the verbiage which will be presented to the user 

in either the Shape Data dialog or the Shape Data dock-able Window. The Sort key is any alpha-numeric 

sequencing for the order the fields will be displayed in the Dialog or Window. Keep in mind that the 

order is based on ASCII character code sequence, not alphabetical or numeric. 

 

This process would be repeated for each additional Shape Data field to be added to the Local Position 

Master SmartShape symbol. 

When all of the desired fields have been added to the Local Master Position SmartShape symbol, Left-

Click to confirm the added fields and close the Dialog. When closed, the Shape Data dialog will be 

updated to reflect the newly added fields. 

Looking at the Shape Data dialog, note that utilizing the Date Data Type provides the use of a Calendar 

Control for selecting dates as part of the filling in of the Shape Data Fields. 
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Once the desired fields have been added to the Local Master Position SmartShape symbol, and all 

functionality has been verified, Left-Click to close the Shape Data dialog. Next close the Master Shape 

Editing Window by selecting the small “X” for the window (being careful not to select the larger red “X” 

which would close Visio completely). Notice the prompt dialog asking if the Position Master and all of its 

instances in the current diagram should be updated. Respond by Left-Clicking on the Yes Command 

Button. This action will close the Master Editing window and update the Local Process Master 

SmartShape symbol and every instance of that Master throughout the entire current Diagram. 

 

After the dialog is closed, Right-Click on the Process SmartShape in the active Organization Chart 

Diagram and choose Properties from the SmartShape symbol’s Context menu. 
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This action will display the Shape Data Window. 

 

Left-Click on the Down-pointing Triangle(�) at the right end of the Date of Hire Shape Data field. Select 

a date of hire from the calendar control. Left-Click the OK Command Button in the Shape Data dialog to 

accept the added data field value and close the dialog. 

 

Repeat the entire process for each Organization Chart Local Master which should have the additional 

information tracked. 

 

Applying Visio 2007 Themes to Organizational Diagrams 
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By default, as Visio creates the Organization Chart Diagram, whether manually or via the Organization 

Chart Wizard, Visio creates white boxes on a white background. Certainly, as was discussed earlier, 

Background pages can be added to the diagram. Regardless of Background or not, the user is still 

confronted with white boxes. This is certainly less than desirable. 

Visio provides a new technology to update an entire diagram with a selected palette of colors and 

formatting options designed to make the Organizational Diagram far more attractive to the viewer of 

the Organization Chart Diagram. The color and formatting options are part of a new technology called 

“Themes”. Themes encompass colors and formatting for each element in a Visio diagram. They are 

consistent across all Visio diagram types. They are also the same themes that can be found in every 

Microsoft Office 2007 application. This ensures a consistent “look and feel” across every document and 

diagram produced by any group within the organization. 

There are two elements to Themes: Theme Colors, and Theme Effects. 

To access Themes, choose Format � Theme… from the Visio Format menu. 

 

This action displays the Theme Task Pane, by default, sized and docked to the Right side of the Visio 

Environment. 
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Theme Colors 

 

Theme Colors will be displayed by default. Near the top of the Theme Task Pane, there are two entries, 

Theme Colors and Theme Effects. Left-Clicking on either of these two entries will display that particular 

Theme Task. 

Theme colors are a pre-defined palette of color sets. To apply any Theme Color, Select one or more 

SmartShape symbols and then Left-Click on any desired Theme Color. The Theme Color will be applied. 

 

Above, note that the Theme Color “Foundry” has been applied to the first page of the Organizational 

Chart Diagram. If, for any reason, a mistake has been made or it has been determined that none of the 

Themes provided are acceptable, Left-Clicking on the None Theme will clear any applied Theme. 

Additionally at the very bottom of the Theme Pane, there is a New Theme Color… item which may be 

Left-Clicked and then a new palette of colors saved under a new Theme name. 

Theme Effects 

 

Theme Effects, like Theme Colors, are a palette of formatting options including things like line style and 

weight, fill patterns, and corner rounding. 
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Above, note that the Theme Effect “Oblique” has been applied to the first page of the Organizational 

Chart Diagram. If, for any reason, a mistake has been made or it has been determined that none of the 

Themes provided are acceptable, Left-Clicking on the None Theme will clear any applied Theme. 

Additionally at the very bottom of the Theme Pane, there is a New Theme Effects… item which may be 

Left-Clicked and then a new palette of formatting options saved under a new Theme name. 

 

04 - Inherent Limitations of Visio Organization Diagrams 

 

This section provides a brief dissertation on some of the known limitations when working with Visio 

Organization Chart Diagrams. This section is, by no means, meant to be a negative commentary on the 

Visio Organization Chart Solution. It is meant to make the user aware of where Visio Organization Chart 

Diagrams “bump up against the wall” of things that the solution, as currently designed. Microsoft is 

always looking for input as to how any of the Visio solutions can be either improved or become even 

more suited to meeting the needs of the Visio community. 

 

Manual Dotted-Line Reporting Only 

 

As was stated earlier, there is no methodology, utilizing the Visio Organization Chart Wizard, to specify a 

“dotted line”, “alternate”, or “secondary” reporting relationship. There does exist a specialized Visio 

Dynamic Connector SmartShape symbol which may be manually applied to represent this type of 

relationship. However since it must be manually applied, it would need to be manually applied each and 

every time that the Organizational Diagram was generated by the Organization Chart Wizard. 
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Use of Pre-Defined SmartShape Symbols Only 

 

The Organization Chart Solution has been very carefully crafted to work in specifically one manner only. 

As such, it is not possible to make use of a user-defines set of SmartShape symbols to represent the 

Organization Chart Employee items. The user must neither replace nor modify (with the exception of 

adding additional Shape Data fields) any of the Organization Chart Master SmartShape symbols found 

on the Local Document Stencil. To be even more precise, the external Organization Chart Shape Stencil 

is, in fact, not used, since in this particular solution, the Master SmartShape symbols are pre-populated 

on the documents own Local Document Stencil, and that is what the solution looks for. 

Any alteration of these Local Master SmartShape symbols can, and will cause many different features, 

like multiple text blocks to display differing information, rendered inoperable. 

 

No Automation for Developer-Defined Layouts 

 

Because the Organization Chart Solution resides within a sealed Visio Add-In, its logic cannot be altered 

in terms of custom layout algorithms. Post-processing by creating additional automation code to change 

the behavior of the SmartShape symbols and their layout will surely, and only, result in ongoing 

frustration. 

Keep in mind that manual dragging of SmartShape symbols still functions just fine. To relocate a team, 

simply drag the superior and all of the subordinates follow. It is that sort of intelligence which blocks the 

automation of these procedures by other post-process applications. 

 

Generated Diagram is Not Refreshable from Source Data 

 

Even though the Organization Chart Wizard looks to a user-specified data source to generate the 

Organizational structure from the external data, the data “connectivity” is simply a one-way, one pass 

activity. As soon as the Organization Chart diagram has been created by the Wizard, the Wizard no 

longer knows about the external data in any manner at all. Because of this fact, Visio and Microsoft have 

historically referred to the Organization Chart Diagrams as being “disposable” diagrams, meaning that if 

the data changes, the user simply generates a new diagram from the changed data. 

As we will discuss later, the Organization Chart, when complete, can be re-linked back to the data using 

the new Visio 2007 Data Connectivity. In this manner, if the existing data is changed, for example a 

person is assigned a new telephone number or office number or a new title, the data CAN be updated 

and reflect that updated data within the Shape Data of the SmartShape symbol.  
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However, if new records are added to the data in the data source, or data records are removed from the 

data source, the Visio diagram will know only that records are missing (resulting in SmartShapes with no 

data in them), or that new records are in the record set but having no idea what to do with the new 

records. Again… attempting to use automation to make the additions and deletions will be thwarted by 

the existing Visio Organization Chart Solution Add-In. Best practice advice is that if this sort of advanced 

updating requirement needs to be built into an organization’s solution, it would be best to create a 

similar but behaviorally different hierarchical data visualization solution. 

 

05 - User Attached External Data and Organizational Diagrams 

 

One of the singular most exciting features of the new Visio 2007 set of features is the ability to have any 

Visio SmartShape symbol connect (in a read only / pull methodology) to any number of data sources 

concurrently. In terms of the Visio Organization Chart Solution this means that Visio can re-connect to 

the source data that the diagram was generated from, AND connect to other data sources that provide 

even MORE data that can be visualized as part of the greater solution. 

In this section the method for attaching to multiple data sources will be detailed. Additionally, a new 

technology for visualization called Data Graphics (which allow Key Performance Indicators) will be 

detailed.  

Keep in mind that both of these new features require the use of Microsoft Office Visio 2007 Professional 

Edition. 

Attaching Completed Organizational Diagram to External Data Sources 

 

In this demonstration of how multiple data sources may be linked to Visio SmartShape symbols and then 

visualized for the newly attached key performance indicators, it is necessary to look at the two data 

sources that will be used. 

Firstly, the data source used to generate the Organizational Diagram, a Microsoft Office Excel 2007 

Workbook looks like that shown below. 
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The data source for additional key performance indicators looks like that shown below. 

 

Note that the one field that these diverse data sets have in common is the Employee’s Name. It was this 

exact same field that was used in the initial pass to actually generate the Organization Chart Diagram. 

Again… the process that is about to be executed is done AFTER the Visio Organization Chart diagram has 

been successfully generated. 

Link Data to Shapes… 

 

The first task is to link a data source to the Visio diagram as a whole. Later the links will be established 

between the individual records and the unique SmartShape symbols. 

Begin by choosing Data � Link Data to Shapes… from the Visio Data menu 
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This action will display the Data Selector dialog. 

 

The first question that requires a selection is “What data do you want to use?”. The potential choices 

are (1) a Microsoft Office Excel workbook, (2) a Microsoft Office Access database, (3) a Microsoft 

Windows SharePoint Services list, (4) a Microsoft SQL Server database, and (5) any Other OLEDB or 

ODBC data source. In the case of this demonstration, the Excel workbook will be selected. Left-Clicking 

on the Next> Command Button advances to the next screen of the Data Selector Wizard. 
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The next step is to browse to the desired data source. Left-Clicking the Browse… Command Button 

displays a File Dialog allowing the user to select the desired file from the network file system. 

 

When complete, the required file name will be displayed in the Text Box. Left-Clicking on the Next> 

Command Button advances to the next screen of the Data Selector Wizard. 

 

Because an Excel workbook was selected, the Wizard offers the user the opportunity to select a specific 

range of data on the worksheet. If no named range is available, the user can create one on the fly or 

simply use the entire worksheet. Left-Clicking on the Next> Command Button advances to the next 

screen of the Data Selector Wizard. 
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Utilizing the Select Columns… and Select Rows… Command Buttons, the user can filter the selection of 

data being used for the data link. 

 

Select Columns… allows individual fields to be included or excluded from the data link. 

 

Select Rows… allows individual records to be included or excluded from the data link. 
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Once any filters have been applied to the data set, the user is returned to the Connect to Data screen of 

the Wizard. Left-Clicking on the Next> Command Button advances to the next screen of the Data 

Selector Wizard. 

 

The Wizard takes a first pass estimate at which field in the data set contains unique record entries and 

offers this as the Unique Identifier. The user may either accept this default, or un-check that option and 

select another. Left-Clicking on the Next> Command Button advances to the next screen of the Data 

Selector Wizard. 
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The final screen of the Wizard simply confirms that the Wizard has all of the necessary information to 

import the data to the Visio Diagram as a whole. Left-Clicking the Finish Command Button confirms the 

user’s choices, closes the dialog and attached the data set to the Visio diagram. 

 

The above process would be repeated to attach the second data source. 

Automatically Link… 

 

With the Data Source attached, the next step is to automatically link the records in the imported data 

source to individual SmartShape symbols. To begin this process, choose Data � Automatically Link… 

from the Visio Data menu. 
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This action will display the Automatic Link dialog. 

 

The first screen of the dialog requests the scope of the linking. The user can opt to either automatically 

link to any specifically selected shapes, or, All shapes on the current page. Ensure that the “All shapes on 

this page” option is selected Left-Clicking on the Next> Command Button advances to the next screen of 

the Automatic Link Wizard. 
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In this screen of the Automatic Link Wizard the user maps the field in the data source to the field in the 

SmartShape symbol’s Shape Data. There is an AND Command Button allowing for multiple criteria, 

however there is no OR functionality. In the case of this demonstration, ensure that Employee (the 

unique key field) is selected in BOTH the Data Column and the Shape Field lists. Left-Clicking on the 

Next> Command Button advances to the next screen of the Automatic Link Wizard. 

 

The final screen of the Wizard restates the actions that have been selected and will be executed. Left-

Clicking on the Finish Command Button closes the Automatic Link Wizard, and scans the diagram for 

matching criteria. Wherever the criteria match, Visio places a small chain-link symbol at the left of the 

record in the data set in the diagram and performs the link. 



Visio 2007 Organizational Diagramming Page 84 

 

 

This would be repeated for each and every page in the diagram, for each attached data set. 

 

Refresh Data… 

 

When data changes in the data set(s), the Visio diagram can be updated to reflect these changes. To 

perform a refresh, either choose Data � Refresh Data… from the Visio Data menu 

 

Or Right-Click on the attached data grid at the bottom of the Visio Environment and choose Data � 

Refresh Data… from the context menu of the data grid.  
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Both methods will display the Refresh Data dialog. 

 

From within the Refresh Data dialog, either Left-Click the Refresh Command Button to refresh the data 

from the currently selected data source, or Left-Click the Refresh All Command Button to refresh the 

data from all listed data sources. Left-Clicking the Configure… Command Button displays a sub-dialog 

which provides options to schedule refreshes on a given interval, as shown below. 
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Data Graphics Sets and Organizational Diagrams 

 

While an amazing amount of intelligence can, and is, programmed directly into Visio SmartShape 

symbols, many solutions are required to maintain the SmartShape symbols in a rigid manner in order for 

the solution to perform in the desired way. Visio has created a new technology under Visio 2007 

Professional called Data Graphics. 

Data Graphics are designed to associate additional sub-SmartShape symbols to existing SmartShape 

symbols. These Data Graphics are often used to display Key Performance Indicators (KPI’s) associated 

with the SmartShape symbols within the diagram. 

There are four distinct types of Data Graphics. A Data Graphic set can include any number of Data 

Graphics at the same time. Any number of Data Graphic Sets can be saved as part of a Visio diagram, 

and any of these Data Graphic sets can be applied at any time the user desires. In this manner a single 

Visio diagram can display numerous KPI visualizations. 

The four distinct Data Graphic Items are: 

• Text Callouts 

• Data Bars 

• Icon Sets 

• Color by Value 

All of these will be discussed and most demonstrated below. 

 

Creating a Data Graphic Set 

 

Data Graphics are created through the Data Graphics Task Pane. The Data Graphics Task Pane is 

accessed by choosing Data � Display Data on Shapes… from the Visio Data menu. 
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This action opens the Data Graphics Task Pane at the Right of the Visio Environment. To create a new 

Data Graphic Set, Left-Click on the New Data Graphic… text item near the top of the Task Pane. 

 

This action displays the New Data Graphic dialog. The New Item Command Button/List reveals the four 

potential Data Graphic Items which may be included in a Data Graphic Set. 
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Text Callouts 

 

Left-Clicking the Text … option displays the New Text sub-dialog. 

 

In this sub-dialog the user can choose from a list of available text callout styles, and select other options 

including the position of the callout, the label, the border type, etc. The user MUST choose the Data field 

that is to be associated with the callout. 
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Data Bars 

 

Left-Clicking the Data Bar … option displays the New Data Bar sub-dialog. 

 

In this sub-dialog the user can choose from a list of available Data Bar styles, and select other options 

including the position of the Data Bar, the label, the minimum and maximum values, etc. The user MUST 

choose the Data field that is to be associated with the Data Bar. 

 

Icon Sets 

 

Left-Clicking the Icon Set … option displays the New Icon Set sub-dialog. 
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In this sub-dialog the user can choose from a list of available Icon Set styles, and select other options 

including the position of the Icon, the label, the logic and values, etc. The user MUST choose the Data 

field that is to be associated with the Icon Set. Note that the user may also create his or her own Icon 

Set to meet their particular corporate needs. Please refer to Microsoft Knowledgebase articles on how 

to create and use new Visio 2007 Professional Icon Sets. 

 

Color by Value 

 

Left-Clicking the Color by Value … option displays the New Color by Value sub-dialog. 
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In this sub-dialog the user can choose from a list of available colors to assign to each possible value 

(note that these colors apply to either or both fill color and text color), and select other options as well. 

The user MUST choose the Data field that is to be associated with the Color by Value. 

 

In the case of the Organization Chart Diagram, the demonstration presumes that the data fields for 

Performance (rating) Completion of Diversity Training, and Completion of Safety Training are attached 

as external data to the Organizational Chart Diagram. 

The illustration below shows three Data Graphics created as part of the Data Graphic Set. The First Data 

Graphic is a Data Bar (in this particular case a star rating), the second and third are Icon Sets (the first 

Icon Set is a “stop Light”, and the second Icon Set is a Check Mark or X symbol). 

 

Data Bar (Rating) 
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Icon Set (Diversity Training) 

 

Icon Set (Safety Training) 

 

Once the Data Graphic Set has been designed, Left-Click on the OK Command Button to confirm the 

choices, close the dialog, and add the Data Graphic Set to the Data Graphics Task Pane collection of Data 

Graphic Sets. 
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Applying Data Graphic Sets 

 

To apply a Data Graphic Set to a Visio Diagram, first select the SmartShape symbols that are to have the 

Data Graphic Set applied to them, then Left-Click on the Data Graphic set in question. 
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Creating Organizational Diagram Reports from within Visio 

 

One of the features built into Visio 2007 (and even previous versions) is the ability to generate Reports 

from Visio Diagrams. This ability can be extremely useful when used in conjunction with the Visio 

Organizational Charting Solution. 

 

Export Organization Data 

 

Before discussing Custom Reports from within Visio, it will be helpful to diverge just slightly for a 

moment and look at how a quick data export can be created from Visio Organizational Diagrams. 

From the Visio Organization Chart Menu, choose Organization Chart � Export Organization Data… 
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This action will display a Windows File Dialog prompting the user to select a path and filename for the 

export as a Microsoft Office Excel Workbook. 

 

 When the Path and File Name have been selected, Left-Click the Save Command Button to confirm the 

choice, close the dialog, and save the export file. When the export is complete Visio will display a 

Message Box informing the user that the export was successful. 
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Next, the user can open the export Excel file and see the data export. 

 

 

Built-In Reports 

 

Every Visio diagram contains at least one Report Definition, an Inventory Report. Based upon the 

Template that the Diagram was based upon, the diagram may contain additional Custom Report 

Definitions. A Visio Organization Chart Diagram will contain the following three Report Definitions: 

• Count Positions 

• Inventory 

• Organization Chart Report 

Accessing all three of these Report Definitions is accomplished in exactly the same manner. 

Choose Data � Reports… from the Visio Data menu. 
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This action will first display a progress bar while Visio locates and loads the applicable Report 

Definitions. 

 

The Visio will display the Reports dialog. 

 

Note that the Count Positions, the Inventory, and the Organization Chart Report Definition listings are all 

displayed in the Reports dialog. 

To run a Report, select the desired Report Definition by Left-Clicking on the desired Report Definition in 

the listing and then Left-Click on the Run… Command Button. 

This action will display the Run Report dialog. 
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Note that there are Four possible Report Output formats available: (1) Excel (Microsoft Office Excel 

Workbook), (2) HTML (.HTML File Output in a Table format, (3) Visio Shape (actually an embedded Excel 

worksheet), and (4) XML (a raw .XML ASCI Text format document). 

Left-Click on any of the desired four output formats, in this case the demonstration will use Excel as the 

output. Finally, Left-Click on the OK Command Button to generate the Report. 

 

Count Positions 

 

Shown below is a sample output from the Count Positions Report. 

 

 

Inventory 

 



Visio 2007 Organizational Diagramming Page 99 

 

Shown below is a sample output from the Inventory Report. 

 

 

Organization Chart Report 

 

Shown below is a sample fragment output from the Organization Chart Report. 

 

 

Custom Reports 

 

If none of the included Report Definitions suit the needs of the user’s organization, then Custom Report 

Definitions may be created as well. These Custom Report Definitions may be either stored in the Visio 

Diagram, or stored to any Network share, such that any other Visio user of the Organization Chart 

Solution would have access to the Report Definition as well. 

 

Creating Custom Reports 

 

To create a Custom Report Definition, begin by launching the Visio Report Tool. As stated before, this is 

accomplished by choosing Data � Reports… from the Visio Data menu. 
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Next, from within the Report Dialog, Left-Click on the New… Command Button. This action will display 

the first screen of the Report Definition Wizard 

 

Note that the user can specify the scope of the Report to be either (a) all shapes on all of the pages in 

the current diagram, (b) all of the shapes on the current page, (c) shapes that are selected, or (d) a 

specific class of shapes such as Organization Chart SmartShape symbols. 

Note also, the Advanced… Command Button. Left-Click on the Advanced… Command Button. This action 

will display the Advanced sub-Wizard Screen 

 

The Advanced Screen allows the filtering of the SmartShape symbols to be included in the report. In the 

case illustrated above, the Shape Data property “Employee” must exist in a SmartShape symbol for that 

SmartShape symbol to be included in the report. This eliminates all dynamic connectors and other 

superfluous SmartShape symbols from being included in the Report. After the Property, the Condition, 

and the Value fields are selected from their respective drop-down lists, the user Left-Clicks the Add 

Command Button to add the given condition. When all proper conditions are set, Left-Click the OK 

Command Button to return to the first screen of the Report Definition Wizard. 

Left-Click the Next> Command Button to advance to the next screen of the Wizard. 

The second screen of the wizard allows the user to specify which fields (Shape Data fields) should be 

included in the Report Definition. Check the specific fields to add to the report definition. 
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Left-Click the Next> Command Button to advance to the next screen of the Wizard. 

The third screen of the wizard allows the user to specify the Report Title, the Grouping, the Sorting, and 

the formatting of the report elements. 

 

Left-Click the Next> Command Button to advance to the next screen of the Wizard. 

The fourth (and final) screen of the wizard allows the user to specify the name for the report definition, 

and the location. 

 



Visio 2007 Organizational Diagramming Page 102 

 

Left-Click the Finish Command Button to accept the choices, close the Wizard, and return to the Report 

Dialog. 

 

From the Reports dialog, the user may now run the Organizational Ranking Report. The output from this 

report is shown below. 

 

 

Comparing Visio Organization Chart Diagrams 

 

Another feature of the Visio Organization Chart Solution, which was introduced with Visio 2003, is the 

ability to compare two organizational diagrams and report on the differences between them. Note that 

this functionality requires two separate Visio Organization Chart Diagram files. This functionality is found 
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by choosing Organization Chart � Compare Organization Data… from the Visio Organization Chart 

Menu while actively working in either of the two Visio Organization Chart Diagrams. 

 

This action will cause the Compare Organization Data dialog to be displayed. 

 

By utilizing the Browse… Command Button, the user may browse to, and select another Visio 

Organization Chart Diagram from within a File Dialog. Upon return from the File dialog, the second 

Organization Chart Diagram will be opened. The user may then specify which of the two diagrams is 

older, in terms of data, and which report type, sorted by change, or sorted by position, is desired. 

Left-Click the OK Command Button to run the comparison report. The output will look similar to the 

illustration shown below. 
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06 - Publishing Visio Organizational Diagrams 

 

There are numerous ways that Visio Organization Chart Diagrams can be published. This section covers 

the most often used methods. The choice for publication is both on a need by basis and a corporate 

policy. The user is advised to choose the methodology that best fits their data sharing requirements. 

 

Publishing to a Printer 

 

The first and easiest is to publish the Visio Organization Chart diagram by sending the output to a 

connected printer. This is accomplished by choosing File � Print… from the Visio File menu. 
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This action causes the Print Dialog to be displayed. 

 

Left-Clicking the OK Command button begins the process of output to the attached printer. 

Publishing to a File 

 

The next method is to simply publish to a file format. This is accomplished by choosing File � Save As… 

from the Visio File Menu. 

 

This action causes the File Dialog to be displayed. 
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By selecting the Save as type drop-down list, the user may choose the desired file output type. 

 

 

.VSD / VDX 

 

Visio’s native file format is .VSD (Visio Diagram/Document). Visio’s alternate XML format is .VDX. 

 

.PDF 
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Visio diagrams may be saved to a .PDF format and subsequently shared with other colleagues who might 

not have access to Visio. 

 

.JPG, .GIF, .BMP, etc. 

 

Visio can save to any number of Graphics formats including .JPG, .GIF, .BMP, etc. These raster formats 

print nicely at their original output resolution, however, like all raster images, they may suffer from 

resizing in terms of clarity of image. 

 

Publishing to the Web (.HTML) 

 

Visio also provides an alternative to the simple publication of the image that is the Visio diagram. Visio 

can also publish as an intelligent Web Page. The output includes both the Visual Diagram but also the 

data as well. The Visio output to the web may be queried for the Shape Data associated with the 

SmartShape symbols. The Visio output may be searched for specific content based on data found in the 

Shape Data associated with the SmartShape symbols. 

Since the graphic output to the Web is VML, the diagram output scales incredibly well, with no loss of 

fidelity when panned and zoomed. The Internet Browser used to display the Visio HTML output includes 

a “Bird’s Eye” window allowing for rapid pan and zoom capabilities. 

The Visio diagram output to the web can also include the report definition output for any and/or all 

reports defined with the diagram. 

07 – Conclusion 

 

While working with the Visio Organization Chart Diagramming Solution may seem daunting at first, a 

reasonable read through this text should arm the user with the skills to master Organizational Diagrams. 

The text has provided literally “Click-by-Click”, “Step-by-Step” tutorials for learning everything about 

creating Organization Chart Diagrams manually, creating Organization Chart Diagrams using the 

Organization Chart Wizard, numerous best practice tips and tricks for both optimizing and enhancing the 

Visio Organizational diagrams, and over 150 illustrations to act as a visual guide to mastering your 

Microsoft Office Visio 2007 Professional Organization Chart Diagramming. 

The best of wishes in your Visio work! 

 


